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Useful Avolites phone numbers:- 

Avolites England 

Sales and service* (+44) (0) 20 8965 8522 

Service out of hours* (+44) (0) 831 17 8888 

Fax    (+44) (0) 20 8965 0290 

Email   name@avolites.com 

Website     http://www.avolites.com 

Distribution of Avolites products in USA:- 
Avolites America 

Sales and service* (+1) 865 938 2057 

Fax    (+1) 865 938 2059 

*Before contacting Avolites for service enquiry please ensure that you have the 
product serial number and the Software version. The serial number can be 
found on the back of the desk near the power socket and on the keyboard 
drawer; the software version is displayed on the title bar of the Pearl 
application on the VDU. 

The latest version of this manual and Pearl Expert Titan Software can 
be downloaded from the Avolites website. 

The small print : 

No Liability for Consequential Damages 

Avolites has a policy of continuous product and documentation improvement. As such the 
detail within this manual may not match the operation of the Pearl Expert Titan. 

In no event shall Avolites be liable for any direct, indirect, special, incidental, or 
consequential damages or loss whatsoever (including, without limitation, damages for loss 
of profits, business interruption, or other pecuniary loss) arising out of the use or inability 
to use the Pearl even if Avolites Ltd. has been advised of the possibility of such damages. 
Because some jurisdictions do not allow the exclusion or limitation of liability for 
consequential or incidental damages, the above limitation may not apply to you. 

Avolites Ltd recognise that all trademarks within the manual are the property of their 
respective owners. 
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1.  Setting up the console 
This chapter contains: Connecting mains power, DMX lines, VDUs; 
configuring the console and the various VDU windows; guide to where 
everything is on the console; loading and saving shows. 

 

This manual applies only to the Pearl Expert Titan console but we’ll 
refer to it simply as “the Pearl”. If you are using the classic Pearl 
Expert, or the Pearl 2008, 2004 or 2000 consoles, they have their own 
manuals as the operation is significantly different. 

 

Note: You can also operate the Pearl Expert Titan in “classic” Pearl 
Expert mode by rebooting the console into the desired mode. 
See section 1.7 on page 25. 

1.1 Guide to the console 
 

 

The Pearl has four main control areas: 

The Master faders set overall levels on the console 
The Preset faders/handles select and control individual fixtures (and you 

can store cues and chases here too) 
The Playback faders and rollers select and control cues and programs 
The Programming and setup controls configure and program the console 

Preset faders / handles Master faders 

Playback faders and 
page select rollers 

Programming and 
setup controls 
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The main controls 

• The Preset Faders are used to control individual dimmer channels 
and fixture intensities. Cues and chases can also be stored on these 
faders. The 2 buttons below the faders are used to select and flash 
whatever is stored on the fader. Each fader and buttons is called a 
“Handle”. 

• The Mode select keyswitch selects Programming, Run or System 
modes of operation. 

• The Page select rollers let you select different pages of playbacks, 
and you can write the playback names on the rollers so you know 
what’s in them. There are 2 rollers each controlling 10 playback faders  

• The Master faders control the overall output of the various parts of 
the console. You will normally have these set at Full.  

• The Playback faders and flash buttons are used to play back cues or 
chases you have programmed, when you are running a show. 

• The Main display is the nerve centre of the console and shows you 
what is going on. The display can show various screens of information.  

• The Control wheels are used to set control values on the fixtures, 
and to set chase speeds and fades.  

Preset faders / handles Mode select keyswitch 

Main display 

Master faders 

Attribute 
select buttons 

Playback faders & 
flash buttons 

Playback page 
select rollers 

Control 
wheels 

Menu 
softkeys 

Command 
buttons Numeric 

keypad and 
controls 

Fixture page 
buttons 
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• The Menu softkeys (labelled A – G) are used to select control options. 
The display next to the buttons shows what each one will do. The 
options for each key change depending on what the console is doing. 
Softkey commands are shown in the manual with square brackets like 
this: A [Edit Times] 

• The Numeric keypad and other control buttons are used to enter 
values and change controls on the console.  

• The Fixture Page buttons are above the keypad, and allow selection 
of 4 pages for the Preset Faders. 

• The blue Command buttons are used to carry out functions such as 
storing cues, copying, saving to disk, etc. These buttons have lights on 
to indicate when they are active. 

• The Attribute select buttons are used to select which attributes of a 
fixture (e.g. colour, gobo, pan, focus) are going to be controlled using 
the Control wheels. The buttons have lights on to show you which 
attributes are active. The bottom (red) button allows you to locate 
fixtures, which sets them to a known start position while programming. 

• A QWERTY keyboard and mouse touchpad is provided in a drawer on 
the front of the console. 

The back panel 

All the connections required for the console are found on the back 
panel. Most are self-explanatory. 

• The Panel reset switch may be pressed to restart the front panel 
electronics if something odd happens with the switches and faders. The 
main board will continue running but the DMX output will be 
interrupted until the restart is completed. 

• The USB reserve sockets and switches are for future expansion. The 
switches should be set to “Normal operation”. 

 

 

 

  

Desk lamp socket 
VDU socket (blue) Ethernet socket (top) 

and 2x rear USB

Mains inlet VDU mounting 
 point 

DMX outputs (4) Floppy disk 

USB reserve 
sockets and 
switches (2) 

MIDI in MIDI out Audio in (blue) 

Panel reset switch 
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1.2 Connecting up 
1.2.1 Connecting mains power 

You can safely connect the Pearl to any voltage from 80 to 260V. 

We recommend that you run the console from a computer UPS 
(uninterruptible power supply) . If the console unexpectedly loses 
power, you can lose data (up to the last Autosave) and the console may 
want to check its disks on startup which can cause delays. The UPS will 
protect you from most power problems and give you chance to shut 
down the console normally. 

1.2.2 Starting up and shutting down 
The Pearl runs a Windows-based operating system internally, so you 
need to make sure it is shut down properly rather than just turning off 
its power.  

Start up the console by pressing and releasing the Power switch at the 
left hand side of the front edge. The console display and VDU screen (if 
you are using one) should come alive. The Pearl takes about 30 
seconds to start up and a progress count is shown on the console 
display. 

Shut down the console by pressing and releasing the Power switch 
again. The console will perform a controlled shutdown. Wait until the 
Power light has gone off (about 15 seconds) before you disconnect 
power from the console. 

To carry out a Forced Shutdown of the console, if the normal shut 
down does not work, hold down the power switch for 5 seconds. 

Note: Do not use the power switch on the rear of the console to 
switch off the console as this would not close down the console 
properly. 

 

1.2.3 Connecting DMX lines 
The Pearl communicates with lighting fixtures using the DMX512 
system. It can produce 12 universes of DMX (each 512 control 
channels). It has 4 physical DMX lines for direct connection to fixtures 
and dimmers, and can also send DMX over Ethernet and wireless 
Ethernet systems to allow connection to remote DMX Ethernet nodes 
and to the Avolites Console DMX Interface (ACDI) system which is used 
to connect visualiser applications. 

When you patch a dimmer or fixture you tell the Pearl which of the 12 
DMX universes it is on. The universes are identified as “lines 1-12” on 
the LCD display and “lines A,B,C,D,E,F,G,H,I,J,K,L” on the VDU. Each 
universe can be configured to come out of one or more of the 4 
standard DMX outputs on the back of the console, or over an Ethernet 
protocol (see section 13 on page 109.)  

The 4 standard DMX outputs come out of the 5 pin XLR sockets on the 
back of the console. They are wired like this: 

Pin 1 Earth 
Pin 2 Data - 
Pin 3 Data + 
Pin 4 Not used 
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Pin 5 Not used 
 

Each DMX line should pass through all the fixtures to be connected on 
that line one after the other and have a DMX terminator fitted at the 
end (120 ohm resistor between pins 2 and 3). You should not split the 
DMX lines using passive splitters (Y-splits) as this can mess up the 
data. 

1.2.4 Connecting VDU monitors 
You should connect a computer VDU monitor to the Pearl, which is 
plugged into the VGA port on the rear of the console. Do not use the 
console without a monitor attached. 

• If you need to change the VDU resolution or settings, click on the 
Windows Control Panel icon on the VDU desktop (see page 19) 
and select “Display”. 

1.2.5 Other connections 
You can connect an external keyboard and mouse to the pc connectors 
on the rear of the console if for some reason you don’t like the 
keyboard with touchpad in the drawer on the front. 

The console provides MIDI connections. MIDI functions will be added in 
a future version of the software.  

You can connect the console to a LAN (local area network) using the 
RJ45 socket on the rear. This allows you to back up the console to 
another machine, or to link to a DMX-over-ethernet system. 

A 3-pin XLR socket for a desk lamp is provided on the rear edge of the 
console. Suitable lamps are available from Avolites. The lamps are 12 
volt, wired from pins 1 and 2 of the XLR. 
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1.3 Using the displays and menus 
The Pearl Expert has many useful features on its onboard display and 
on the VDU. 

1.3.1 The onboard display 

Down the right hand side of the display, the functions of the A-G menu 
softkeys are listed. If there are more functions than will fit on one 
screen, F [Previous] and G [Next] buttons are provided to page through 
the functions. 

The vertical bar to the left of the softkeys shows you which menu you 
are currently in. You can “latch” the menu (so that you don’t have to 
keep reselecting it) by pressing the ML Menu button. 

At the bottom left of the screen, the current function of the wheels is 
shown. If fixture attributes are being set, this shows the possible 
settings which are available on the fixtures. The horizontal bar shows 
which attributes are being controlled by each wheel and the boxes show 
the current attribute. If a chase is being controlled, information about 
the chase is shown here. 

The area at the top left of the screen shows instructions to the user and 
information from the console. 

The appearance of the softkeys shows what they will do: 

    

Action button: 
console will carry 
out the action 
shown 

Option button: 
cycles through a 
range of options 

New menu 
button: jumps to 
a new menu 

Text entry 
button: press 
and enter text 
using the 
keyboard 

Menu 
softkeys 

Current 
menu name 

Instructions 
to user 

Wheel A/B 
attributes 

List of 
settings 

Current 
selection 
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1.3.2 The VDU desktop 
The desktop is your view into what the Pearl is doing. It can display 
windows showing Intensity output, Stage output, DMX output, and you 
can also turn on or off views of the command line and status bar. 

To access Windows functions such as File explorer (to move files 
around), Control Panel (to setup hardware), and to stop or restart the 
Pearl application or run other programs, icons are provided in the 
Avolites toolbar on the right hand side of the VDU screen. 

Use the View menu to show or hide the various information screens 
available in the Pearl application. 

The Virtual Panel brings up an on screen version of the console front 
panel, this allows the 
operator to perform on 
screen all of the functions 
normally accessed from the 
panel. Use the Virtual Panel 
icon on the Avolites toolbar 
to show this. 

The Intensity view shows 
you the intensity output of 
all patched fixtures. The 

USB expert 
Folder browser 

Windows control panel 
Other Programs 

Reboot Titan/Normal 
Restart Pearl software 

Stop Pearl software 

Heads Up Display (HUD) 
showing presets and playbacks 

Pearl application menu and windows 
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brightness of the graphic shows the intensity of the fixture (White=Full 
intensity, dark grey=Off). The intensity is also shown as a percentage. 
By right clicking on this screen you can also enable or disable display of 
the Legend, control group, DMX address and dimmer curve of each 
fixture.  

Fixtures are highlighted in light blue if their output has been changed 
by the user (in other words, they are in the programmer). They are 
highlighted in dark blue if they are currently selected (they are in the 
editor and the programmer). 

 

The Stage view shows you the detail of all fixtures patched on the 
console. You select the fixture type to view using the tabs across the 
bottom of the screen.  

Again the light blue colour shows fixtures which are in the programmer 
and dark blue shows fixtures selected to the editor. Any changed 
attributes are shown using Cyan.  

The window shows the output value of each attribute of each fixture. If 
the fixtures are under control of a playback or palette, the display 
shows what last controlled each attribute. 

You can sort the fixtures on the screen by any of the columns; just click 
on the column header. Click again to reverse the sort order. You can 
change the order of the columns by dragging them to a new position. 
By right clicking on this screen you can enable 
or disable highlighting of changes, and display 
of playback/palette control of attributes. 

The Show Library view allows the operator to 
view any aspect of the recorded show 
(playbacks), and edit times on screen in a 
spreadsheet like manner. 

The Wheels view shows the parameters 
available on each wheel. 

The DMX view shows the output value of each 
DMX channel, and which fixture is patched to it. 

As with the stage view, you can sort the list on 
any of the columns by clicking on the column 
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header, or reorder the columns by dragging. 

The red values indicate values which are currently changing. 

The VDU screen also has a Command Line window, which shows the 
commands that the console is currently processing and provides useful 
feedback, and a status bar which shows what the on-board menu 
displays are currently showing. 

The operating options of the console are set from the VDU screen Tools 
menu, see section 11.2.3 on page 92 for details. 

1.3.3 The Heads-Up Display (HUD) 
The HUD windows show you what is stored in each fader and button on 
the console: cues, chases, fixtures, dimmers, palettes, and fixture 
groups. Any legends you enter are shown here. You can move these 
windows around using the trackpad to meet your requirements. You 
can resize the windows by holding Alt on the QWERTY keyboard and 
dragging an edge of the window using the trackpad. 

 

 

1.3.4 Visualiser 
The Pearl Expert 
runs Avolites 
Visualiser 
internally. This 
allows you to view 
the output of the 
console if you can’t 
use the real lights, 
enabling you to 
make changes to 
your show at home 
or in your hotel. 
You can show or 
hide (minimise) 
Visualiser by 
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pressing View (right of numeric keypad) then A [Show/hide Visualiser]. 
You need to select the “Simulator” option on Visualiser to make it read 
the output of the Pearl. 

The operation of Visualiser is not covered in this manual, please refer to 
the Visualiser manual. 

Auto Patch 

The Auto Patch function automatically creates a Visualiser rig from your 
Pearl show. When you start Visualiser using softkey A on the View 
menu, Visualiser will open with an automatic representation of your 
patch. 

You will see the fixtures laid out on screen as they are on the console, 
so any spaces between fixtures will be preserved and fixtures patched 
to the top row of presets will be shown above fixtures patched to the 
bottom row of presets. 

If you have patched across multiple pages, each page of fixtures will be 
separated by a truss to make it easy to identify them. The Visualiser 
will start in run mode, with the simulator tab selected so you can start 
controlling lights immediately. 

Multiple dimmers patched to one handle will appear as a singe fixture in 
Visualiser. 

1.3.5 Key profiles 
The Pearl allows you to reconfigure how the front panel buttons work to 
suit your method of working. You can save your settings as a Key 
Profile. Different profiles can be selected for different users or to 
enhance the operation of the console for a particular use. See section 
11.3 on page 100 for details. 

1.4 Loading and saving shows 
You can save any number of different shows on the Pearl’s internal hard 
disk. The Pearl will also autosave the show periodically. 

Note:  You cannot transfer shows between the Pearl Expert Titan and 
other versions of the Pearl or Pearl Expert as the showfile 
format is different.  

 

1.4.1 Autosave  
The Pearl will automatically save your show to its internal hard disk 
when you shut it down. It will also autosave the show every 30 minutes 
in case the console loses power. The time remaining to the next auto 
save is shown on the status bar of the VDU window. 

You can disable Autosave or alter the time between saves using option 
D [Auto Save] on the Disk menu (selected using the blue Disk button). 
Softkey A enables or disables autosave and Softkey B sets the time 
between saves. We recommend that you have autosave enabled while 
programming in case the console power fails, but disable it while 
running a show as it can cause the console to pause slightly at 
inconvenient moments. 

1.4.2 Manual save and load 
You can also save your show at any time either with its current name or 
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with a new name. 

1> Press the blue Disk button (bottom right). 

2> Press C [Save Show]. 

3> Enter a name for the show on the keyboard. 

4> Press Enter or A [Save]. The show will be saved. 

5> Press Exit or A [OK] to leave Disk mode. 

Shows are saved in the C:/Program Files/Avolites/Titan/ShowData 
folder, unless you change this in the User Settings. 

The Pearl will automatically load the last show when it is turned on.  

If you want to load a different show: 

1> Press the blue Disk button. 

2> Press B [Load Show]. 

3> Available shows are listed on the softkeys; press the key to load 
the show (the F and G keys show more pages). If you type the 
first few letters of the show name on the Qwerty keyboard, the 
list will only include shows starting with those letters, which can 
make it easier to locate the show you want. 

4> Press Exit to leave Disk mode. 

You can save any number of different shows on the Pearl’s internal hard 
disk. 

1.5 Backing up the show to USB drive 
It’s a good idea to regularly copy a backup of the show to an external 
storage device such as a USB pen drive or floppy disk just in case 
something bad happens to the console. You can’t do this from buttons 
on the console, you need to use the VDU and mousepad to select 
options from the Pearl Expert Titan window on the VDU. 

1.5.1 Backup current show to USB pen drive 
You can save the current show to a USB pen drive or floppy disk using 
the Save Show menu command on the VDU. 

1> Insert a USB pen drive in a spare USB socket, or insert a floppy 
disk (larger 
shows may 
not fit on a 
floppy disk). 

2> On the VDU 
screen, click 
on the File 
menu and 
select “Save 
Show” . 

3> Pull down the 
“Save in” list 
and select the 
drive where 
you want to make a backup of the show (Floppy drive or 
removable USB drive; you cannot save to a CD drive this way). 

4> Type a filename for the show in the “File name”. 



Page 24 – 1. Setting up the console 

 

  PearlExpertTitan_Man_v1-2.doc  17/07/2009 16:38:00 

5> Click on Save. 

 

To reload a saved show from a removable device (including a CD) use 
the Load Show option on the VDU File menu. 

1.5.2 Backup existing show files to USB pen drive 
To backup existing show files to USB drive you need to copy the 
showfile across 
using Windows 
functions. 

1> On the VDU 
screen 
toolbar, 
click on the 
Windows 
Folder icon 
(top right). 

2> Double click 
on “Local 
Disk (C:)”  

3> Double click 
on the 
“Program Files” folder. 

4> Double click on the “Avolites” folder, then double click the “Titan” 
folder, then double click the “ShowData” folder.  

5> The VDU screen will show a list of the saved shows. 

6> Click on the show you want to backup. If you want to backup 
more than one, hold down the Ctrl button on the keyboard while 
clicking them. 

7> Right click on a selected file, and select “Send to” from the pop up 
menu which appears. 

8> Select the removable USB drive where you want to make a 
backup of the show file(s). The file will be copied. 

9> You cannot burn files to CD-R, you must use a USB drive. 

1.6 Clearing the console 
When you start a new show on the Pearl it is usually a good idea to 
clear the console. All programming and patching is deleted, but user 
options are not changed. 

1> Press the blue Disk button. 
2> Press A [New Show]. 

3> Press A [OK] to confirm. 

4> Press Exit to leave Disk mode. 

• There is also a “Wipeall” function in the System menu (when the 
key is turned to System) which has the same function. 
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1.7 Rebooting into original Pearl Expert mode 
You can run the Pearl Expert in 
either Titan mode or the original 
Pearl Expert mode. Click the 
Reboot Mode button on the VDU 
toolbar to reboot the console into 
the desired mode.  

 

Reboot into different 
mode 
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2.  Patching 
This chapter contains: patching dimmers; patching moving light 
fixtures; checking the patching; changing the DMX address; deleting a 
patched fixture; patching options.  

Patching is the process where you tell the Pearl  

• What type of lighting units you have connected to it 

• What DMX addresses they are operating at 

• Which DMX line (universe) each unit is connected to (there are 12) 

• Which Preset Faders you want to use to access them 

You should normally plan out the lighting rig in advance to allow the 
DMX addresses on your fixtures to be set up before they are rigged. 
The easiest way to do this is to patch the fixtures on the console, then 
read off the DMX addresses from the console (using the DMX window 
on the VDU) and use them to set up the addresses on the actual 
fixtures.  

Alternatively you can allocate the DMX addresses to the fixtures 
yourself, and set up the console to match. 

The Pearl’s key must be set to Program before you can patch. 

2.1 Create 
2.1.1 Preset faders (handles)  

To control intelligent fixtures or 
dimmer channels, they must be 
patched to a Preset. These are 
the faders, buttons and displays 
located in 2 rows along the top of 
the console. Each preset consists 
of:  

• a fader, used to set the 
intensity of the fixture or 
dimmer  

• a blue Select button which is used to select the fixture 

• a grey Palette button which is 
used to store and select 
Palettes, Groups and various 
other things 

The fader and buttons are together 
referred to as a handle. 

The fixture page buttons are 
located just above the numeric 
keypad. Fixtures 1-60 are on page 
0--, Fixtures 101-160 on page 1--, 
201-260 on page 2—and 301-360 
on page 3--. You can change the 
fixture page at any time. 

Handles (Preset faders) 

Pages of fixtures buttons 



Page 28 – 2. Patching 

 

  PearlExpertTitan_Man_v1-2.doc  17/07/2009 16:38:00 

The Pearl also allows you to allocate fixtures and dimmers to Groups, 
which can be useful if you usually select the same set of fixtures 
together. Groups are described in the next chapter. 

 

2.1.2 Patching dimmers 
Each dimmer channel is allocated to one fader. 

1> Press Patch (one of the blue command buttons bottom right), 
then A [Dimmers].  

2> Softkey A [Line=] shows you which of the 12 DMX output lines 
you are patching onto. Press A then enter a new number (1-12) to 
change the line. Softkey B shows the DMX address about to be 
patched. You can change this by pressing B [Address=xx], typing 
in the new address on the numeric keypad and pressing Enter.  

3> To patch a single dimmer, press a preset Select button. To patch 
a range of dimmers, hold down the Select button for the first 
dimmer in the range, then press the last Select button in the 
range. The range of dimmers will be patched to sequential DMX 
addresses. 

4> The Select buttons light up dimly to show that they are patched. 

5> Repeat from step 2 for other dimmers. 

• To see how DMX channels are patched, open the DMX window on 
the VDU screen. (use the mousepad to select View > DMX). 

• C [User Number = xx] allows you to set a user-defined number for 
each dimmer or fixture patched, to help you identify them later. 
You can also edit the User Number from the Repatch Fixture 
menu. 

• You can patch multiple dimmer channels to a single handle. This 
can be useful if, for example, you want to control all the lights for 
one area from a single fader. To do this, just press the same 
handle Select button again when patching the new dimmer 
channel. You can tell the dimmer channel has patched OK because 
the DMX address will increase by 1. 

 

2.1.3 Patching moving light fixtures 
Moving light fixtures are more complicated to patch than dimmers 
because they have more attributes to control, such as pan, tilt, colour 
etc., whereas a dimmer channel just has intensity.  

The Pearl uses a “personality” system to control fixtures. This means 
you don’t have to know how each fixture works, you just tell the Pearl 
what you want to do and it will send the right control commands. There 
is a personality file in the Pearl for most types of fixture, which tells it 
what attributes are available and how to control them. If the Pearl does 
not have the personality for your fixture, you can download further 
personalities from the Avolites website or Avolites can create one for 
you. See section 12 on page 105 for details of how to find personalities. 

1> Press Patch (bottom right of console). 

2> Press B [Fixtures]. 

3> Select correct fixture manufacturer from the softkeys (F and G 
page through the list of manufacturers). Or use Quick Search and 
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type the first few letters of the manufacturer’s name on the 
keyboard to find the one you 
want. 

4> Select correct fixture from 
the softkeys (F and G show 
other pages). You can use 
Quick Search here as well. 

5> Select the correct fixture 
operating mode from the 
softkeys. 

6> Softkey B shows the first 
free DMX address. Type the 
new address on the numeric 
keypad if you want a 
different one. Press A [DMX 
line=xx] to patch to a 
different DMX line. 

7> Press a Preset Select button 
to patch the selected fixture. 

8> The Select button will light 
up dimly to show that it is 
patched.  

9> Repeat from 7 to patch 
more of the same fixture 
type. The DMX address 
automatically updates so 
you can just keep patching 
by pressing Select buttons. 

• You can patch a range of 
fixtures by holding down the 
first and last Select buttons 
of the range, in the same 
way as for dimmers. 

• You cannot patch more than 
one fixture onto a preset. If 
the preset is already used, 
the patch will fail.  

• G [Preset Palettes] sets 
whether the console will create default colour, gobo and position 
palettes for the new fixture. These are assigned to palette handles 
1-30. 

• Use the View > DMX option on the VDU screen to show the DMX 
address for fixtures. 

• If a patch goes over the capacity of a DMX line, the Pearl will 
patch at the beginning of the next line. For example if you try to 
patch a Mac500 at channel A510, it will actually be patched at B1. 

2.1.4  Visualiser Auto Patch 
If you want to use Visualiser on the console, start Visualiser by pressing 
View then A [Show Visualiser]. Visualiser will open with an automatic 
representation of your patch.  

You will see the fixtures laid out on screen as they are on the console, 
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so any spaces between fixtures will be preserved and fixtures patched 
to the top row of presets will be shown above fixtures patched to the 
bottom row of presets. 

 

 

2.2 Edit 
2.2.1 Changing the DMX address of a fixture 

You can re-patch a fixture to a different DMX address or a different 
DMX output line. All programming is kept. 

1> Press Patch (if you’re not already in Patch mode). 
2> Press E [Repatch Fixtures]. 

3> Press the blue Select button of the fixture you want to change. 

4> To change DMX press B [Address], type the new address and 
press enter 

5> To change the DMX output line, press A [DMX Line=x] and enter a 
new output line number 1-12. 

6> Press Enter or E [Repatch] to confirm the change. 

7> Repeat from step 3 if you want to change other fixtures. 

• You can “Park” the fixture using D [Park]. This removes the fixture 
from the DMX output map, but all programming is retained. 

• If the new DMX address already has another 
fixture or dimmer patched on it, the console will 
display a warning sign next to the address. If you 
proceed with the change, the console will offer you two options to 
fix the problem. Select B [Select another address] to abort the 
change or A [Park] to “park” the conflicting fixture. All 
programming for the parked fixture is preserved, but you need to 
repatch it to a free DMX address using the above procedure before 
you can use it again. 

2.2.2 Setting legends 
You can set a legend for each fixture or dimmer you’ve patched which 
is displayed on the heads-up display on the VDU. This can be really 
useful to help you identify the fixture. 

1> At the main menu press C [Set Legend]. 
2> Press the Select button for the fixture you want to legend. 

3> Type the legend on the keyboard.  

4> Press Enter when you have finished. 

• You can set the same legend for multiple fixtures by selecting the 
group of fixtures before pressing C [Set Legend]. 

• You can automatically allocate User Numbers for multiple fixtures 
by selecting a group of fixtures, then using softkey A on the Set 
Legend menu. The first fixture will have the User Number you 
entered, and the other selected fixtures be given a number 
increasing by 1 for each fixture.  
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2.2.3 View Fixture Patch 
 The fixture patch view allows you to see how fixtures are patched on 
the console.  
To open the fixture patch view, press the white View button (next to 
the numeric keypad) followed by 
E [Fixture Patch]. You should now 
be able to see a table on the LCD 
screen showing all your fixtures. 
The list of fixtures can be filtered 
by typing in a search term on the 
Qwerty keyboard. You can also 
use the wheels to scroll around 
the list and select different 
fixtures. As you select a fixture its 
handle will be highlighted by a 
pulsing LED.  
You can edit the patch settings by 
pressing A [Edit] to enter edit 
mode, then using wheels A and B 
to scroll to the item you want to 
edit. Then just simply press Enter 
and start typing.  

Please note that some values are 
input in the following form: 
-Handle Number: {Page}.{Index} 
-DMX address: {Universe}.{Address}.  

You can choose which columns are displayed by selecting C [Columns] 
and choosing which columns to hide or show. 

2.3 Copy 
2.3.1 Copying a patched fixture 

You might want to do this if you need an additional fixture of a type 
you’ve already patched and programmed. The new copy will come 
complete with all the cues and palettes of the original fixture you’ve 
copied. 

The copied fixture will be “Parked” (have no DMX channel allocated) 
and you will need to repatch it before you can use it (see section 2.2.1 
above).  

1> Press the blue PhotoCopy button. 
2> C [Copy legends] allows you to either copy the legend as well, or 

if set to [Don’t copy legends], the Pearl will generate a new 
legend. 

3> Press the Select button of the fixture you want to copy. 

4> Press the Select button of the empty Preset where you want to 
patch the copy. 

 

• The ML Menu button latches the Copy menu, so you can keep 
copying things without having to keep pressing the PhotoCopy 
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button. Press Exit to leave Copy mode. 

• Softkey B selects [Retain Layout] or [Bunch Up]. This is used 
when copying a group of fixtures with empty handles in the group 
– you can either keep the empty handles, or bunch up the used 
handles together. 

• When you copy a fixture it is automatically included in any groups 
which the original fixture was in. 

2.4 Delete 
2.4.1 Deleting a patched fixture 

You can delete a fixture or dimmer from a preset if you patched it 
accidentally or if you change your rig and want to use the preset for 
something else. 

1> Press the blue Delete button. 
2> Press the Select button of the fixture you want to delete. 

3> The LCD will show what you are deleting. Press the Select button 
again to confirm. 

• All programming for the fixture is also deleted. You cannot undo 
deletion of a fixture or get the programming back by repatching a 
fixture to the same handle. 

2.5 Moving 
2.5.1 Moving a fixture to a different handle 

You can move a dimmer or fixture from one handle to another using 
the Move function. You can also move a group of fixtures in one 
operation. 

1> Press the blue PhotoCopy button. 
2> Press softkey A until the option selected is [Move]. Pressing 

PhotoCopy again will also toggle this option. 

3> Press the Select button for the fixture you want to move. To move 
a group, hold the first select button and press the last of the 
group. 

4> Press the Select button for the handle where you want the fixture 
to end up (or the handle for the first one in the group if you are 
moving a group). 

• ML Menu button latches the Move menu, so you can keep Moving 
things without having to keep pressing the Move button. Press Exit 
to leave Move mode. 

• Softkey B selects [Retain Layout] or [Bunch Up]. This is used 
when moving a group of fixtures with empty handles in the group 
– you can either keep the empty handles, or bunch up the used 
handles together. 

2.6 Advanced options 
2.6.1 Swap pan and tilt 

This allows you to make the pan channel control tilt and the tilt control 
pan. This is useful for moving-mirror fixtures rigged sideways. 
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1> Press Patch. 

2> Press D [Edit Fixtures] 

3> Press A [Swap Pan and Tilt]. 

4> Select the fixtures to be pan-tilt swapped. Press A [Pan and Tilt 
…] to select either [Swapped] or [Normal] for the selected 
fixtures. 

5> Press Exit when finished. 

 

2.6.2 Invert attributes 
This option inverts individual attributes of fixtures. Useful if you have a 
fixture which pans right when the rest pan left, saving a trip up the rig 
to set fixture options, but you can invert any attribute. 

1> Press Patch. 
2> Press D [Edit Fixtures]. 

3> Press B [Invert Attribute] 

4> Select fixture(s) to be changed. 

5> Select the attribute to invert from the softkeys. The display shows 
[Inverted] when the attribute is inverted. 

6> Press Exit to finish. 

• You can change the invert on multiple fixtures by selecting more 
than one, but the “Inverted” display will not show if there is a 
mixture of inverted and non-inverted fixtures in the selection. 

• Some attributes cannot be inverted. 

2.7 Fixture Exchange 
The Fixture exchange function enables you to replace fixtures which are 
used in your show with alternative fixtures, retaining important 
elements such as cue times, shapes and legends. It is an important 
feature for touring shows and venues with a high turnover of events. 

For example, if you have programmed your show in a venue which has 
MAC 500s and are moving to a venue with VL6s you can exchange the 
MAC 500s for VL6s whilst retaining many elements of your show. 

The pan, tilt and dimmer will always be preserved from one fixture type 
to the next, as will times, shapes and legends for recorded items. 

In order to maximise the Exchange function, you should use Palettes to 
create your cues wherever possible. This will allow you to adjust for 
position differences and so on by reprogramming a few position 
palettes, rather than having to reprogram every cue. 

Cues recorded with absolute values direct from the fixture(s) will need 
to be re-recorded, preferably using palettes. 

Links from the palettes to groups, cues, chases and cue lists will also be 
preserved, so the show can be easily recreated by updating your 
palettes as normal.   

Fixture exchange also gives you a powerful way to re-use an existing 
show with new lights, so you can give yourself a programming head 
start when faced with a new fixture.  

It is always advisable to save your show before performing major 
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changes such as fixture exchange. Should you change your mind, you 
will easily be able to return to your show to its previous state. 

 

The picture on the next page shows the Fixture Exchange window. 

 

 

1> On the VDU click Tools, Exchange Fixture 
2> Use the three dropdown boxes at the top of the screen to select 

the new type of fixture. 

3> Select the existing fixture(s) you want to exchange. You can 
select individual rows or click and drag to select a range of 
fixtures. 

4> Click Assign to set the new fixture type. The table can be sorted 
by any column by clicking on the head of that column 

5> You can set the new DMX link and address for each fixture in the 
table. 

6> When setting the DMX addresses some rows in the grid may 
change colour. Blue means that this is the currently selected 
fixture. Grey means that this fixture DMX address has been used 
elsewhere and this fixture will be parked when exchanged. Red 
means that this fixture has been assigned to an illegal DMX 
address. 

7> Repeat steps 2 – 6 to exchange other fixture at the same time. 

8> Once all the changes have been made click Exchange 

Note: After exchanging fixtures you will have to update the palettes 
which used those fixtures. If you have trouble switching values 
off in a palette you need to re-record the palette with all the 
attributes in an attribute group with new values. You should 
then be able to switch off an attribute group as required. 
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3. Controlling dimmers and fixtures 
This chapter contains: Selecting fixtures and dimmers for control; 
changing attributes of the selected fixtures; using groups.  

When you are programming a show, and sometimes when you are 
running a show, you need to manually control the fixtures and dimmers 
to set the intensity, position, colour, etc. To do this you first select the 
fixtures you want to change using the Swop buttons, then you set the 
attributes of those fixtures using the Wheels and Attribute buttons. 

3.1 Create 
3.1.1 Selecting fixtures and dimmers for control 

To select the fixtures or dimmer channels that you want to control, you 
use the blue Preset Select buttons (below the preset faders) to load the 
fixtures into the Editor. You can select fixtures or dimmers individually, 
or several at once.  

You can control dimmer channels and fixture intensity directly from the 
preset fader, or select the channels as described below and use the 
Dimmer wheel. 

1> Press the blue Preset Select buttons for the fixtures you want. The 
select button will light up brightly for selected fixtures (they are 
also shown in dark blue on the VDU HUD and “Stage View” 
screen). 

2> To select a range of fixtures, hold down the Select button for the 
first fixture then press the Select button for the last fixture. 

Here are some other things to know: 

• Press Locate (red button at the bottom right of the console) to 
light up the selected fixtures in open white and move them to a 
central position. See the next section for more Locate options. 

• You can deselect a fixture by pressing the select button again.  

• Once you have changed any attribute, pressing a preset Select 
button will deselect all fixtures and start the selection process 
again. All previously selected fixtures (since you last pressed 
Clear) stay in the programmer. They are shown in blue on the 
VDU Stage View window.  

• Press Clear (right of numeric keys) to deselect all fixtures and 
remove all changes from the programmer. See the next section for 
more Clear options. 

• The intensity of the fixture is shown 
as a bargraph on the HUD. In the 
User Settings you can set the LED 
in the Select button to mimic 
brightness rather than show fixture 
selection (see section 11.1.3 on 
page 91).  

• You can select fixtures on another page by pressing one of the 
Pages of Fixtures buttons (above the numeric keys). Palettes, 
groups and any cues you have saved on the preset faders will also 
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change with the fixture page. 

• If a preset is active (the fader is raised) when you change page, 
you may want to control a fixture on the new page using the same 
preset. In this situation you have to match the fader level to the 
existing fixture level before the fader will take control. For 
example if preset 1 is on at 100%, you change to page 2 and want 
to control the fixture on preset 1 on page 2. If the page 2 fixture 
is currently Off, you will have to lower the fader to zero before it 
takes control. If the page 2 fixture is at 50%, the fader will take 
control when it matches the 50% value.  

3.1.2 Locate 
The Locate  button (the red button on the bottom right of the console) 
is used to put the fixture into a known position with light coming out, so 
that you can start programming it. 

A quick press of the button will move all selected fixtures to a central 
position and reset all the attributes so that you get a white light. 
However you sometimes might not want to move the fixture, and by 
holding down the Locate button, you get some more options. 

• You can mask off some of the Locate settings  (such as only 
turning the fixture on, but not changing its position or colour) by 
holding down Locate and pressing B [Set Mask to Exclude All]. 
Then (still holding Locate) turn on the Attributes you want to 
change using the Attribute Bank buttons down the right hand side. 
Only the lit attributes will be changed by Locate. Pressing the 
Attribute Options (Bank Select) button will clear the mask.  

• Option D [Auto Reset Mask] sets the mask to be automatically 
reset to include everything each time Locate is pressed, or you can 
toggle the option to [Remember Mask] which will keep the mask 
setting you used last time. 

• Option E [Clear/Don’t Clear Located Attributes] sets whether the 
attributes changed by the Locate function will be saved into any 
cues you store. If the option is set to “Clear” then the Located 
attributes will not be stored in the Programmer unless you modify 
them using the wheels. This is useful if for example you want to 
program a cue which sets the position of fixtures, but does not 
turn them on. The Locate button will light up the fixtures for 
programming, but the lit state will not be stored in any cues you 
save. 

3.1.3 Clear 
The Clear button (on the right of the numeric keypad) is used to 
remove all changes from the Programmer and deselect all fixtures.  A 
quick press of the Clear button just clears everything, however if you 
hold down the Clear button, then more options are available. 

• You can mask which attributes are to be cleared (for example, 
leaving the pan/tilt in the programmer but clearing everything 
else) by holding down Clear and pressing B [Set Mask to Clear 
Nothing]. Then (still holding Clear) turn on the Attributes you want 
to change using the Attribute Bank buttons down the right hand 
side. Only the lit attributes will be cleared. Pressing the Attribute 
Options (Bank Select) button will clear the mask.   

• Option D [Auto Reset Mask] sets the mask to be automatically 
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reset to clear everything each time Clear is pressed, or you can 
toggle the option to [Remember Mask] which will keep the mask 
setting you used last time. 

• Option E [Clear All Fixtures/Selected Fixtures] sets whether all 
fixtures will be cleared from the programmer, or if only currently 
selected fixtures will be cleared. This is useful if you want to clear 
specific fixtures. 

• Option F [Leave/Zero Preset Fader Levels] sets how the console 
deals with intensity levels which are set on the preset faders. 
Normally pressing Clear will remove levels from the Programmer, 
but the intensity will remain set on the output. If this option is set 
to [Zero Preset Fader Levels] then the intensity will also be set to 
zero on the output. This is useful to kill fixtures which have been 
left on from a different fixture page. 

• Option G [Individual Attributes] allows you to clear individual 
attributes from the Programmer. When you press softkey G, you 
are given a list of attributes in the Programmer – press the 
appropriate softkey to clear that attribute. 

 

3.1.4 Changing attributes using the wheels 
“Attributes” are the functions of the fixture, like pan, tilt, colour, 
dimmer, etc. You select which 
attributes you want to modify using 
the buttons on the right edge of the 
console and set values using the 
wheels at the bottom of the Pearl. 
The attributes available depend on 
the fixture type. Dimmer channels 
only have a dimmer attribute. 

Each attribute button controls two 
attributes, one on the left wheel and 
one on the right wheel. 

1> With some fixtures selected, 
press the button for the 

attribute to be changed 

2> Turn the wheels to set the 
attribute. The display above 
the wheels shows which 
attributes are being 
controlled, and the settings 
which are available scroll up 
and down as you turn the 
wheels. 

3> Repeat from 1 to change 
other attributes of the 
selected fixtures. 

Some other things to know about 
attributes: 

• If an attribute is in the 
programmer, it is highlighted 

Attribute select buttons 

Control wheels 
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(as shown with the “Deep Blue” setting in the screen picture 
here). This provides a quick way to see if attributes are in the 
programmer or not. 

• The Attribute buttons let you select the attribute to set. You can 
also select the attribute from the softkeys by pressing the 
“Attribute Banks” button. 

• If the display above the wheels does not show the attribute when 
you press the button, that attribute is not available on the 
selected fixtures. 

• You can directly control the intensity of the fixture/dimmer using 
the fader of the handle. 

• The wheels operate in an “acceleration” mode. If you spin the 
wheel fast, the fixture changes in larger steps. If you move the 
wheel slowly, the fixture moves in its smallest increment. 

• Holding down the Avo button while turning a wheel puts the wheel 
into “Fast” mode. When in this mode, a single rotation of the 
wheel changes the attribute you are controlling over its full range. 
For example, if while moving the Pan wheel you hold down shift 
the fixture will make a complete pan movement between end 
stops in one rotation of the wheel. 

• You can view the available settings (Gobo names, etc) of the 
wheels on the VDU by selecting View->Wheels on the VDU menu 
bar. A Colour Picker control will be available from v1.2. 

• Some LED colour mixing fixtures have a Virtual Dimmer function 
(using the Intensity wheel) which offers intensity control by 
mastering the RGB levels when the fixture itself does not provide 
an intensity channel. 

3.1.5 Setting attributes by number 
You can directly enter a numeric value for the attributes which are live 
on the wheels. You must be at the main Program menu to do this (keep 
pressing Exit until the vertical menu bar shows “Program Menu”).  

Type a number on the numeric keypad then press 
softkey E or F to set the value to wheel A or B. The 
Softkey legend will show what effect your value is 
going to have (such as [Gobo 5], or [Deep Blue]). If 
your value is invalid for that attribute, a warning 
symbol is displayed as shown on the right. 

For attributes displayed in percent, such as Dimmer, or Colour Mix, you 
enter a value from 0-100 to set the percentage output. For attributes 
where the output is divided up into ranges, such as colour wheels, you 
enter the index of the range you want. For example to select the 3rd 
colour (as displayed in the list above the wheel) you would enter 3. 

3.1.6 Selecting fixtures and dimmers by number (Channel) 
In some situations, for example when programming lots of dimmers, it 
can be easier to type in the dimmer channels you want to program. The 
Channel menu allows you to do this for dimmers or fixtures. To access 
the Channel menu, press the Channel button on the top left of the 
numeric keypad. 

Fixtures may be selected by User Number, Handle Number or DMX 
Address, as set by the option on Softkey A. 
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When using the Channel menu it is helpful to latch it by pressing the ML 
Menu button. 

• To select a fixture, type the number and press Enter. 

• To select more than one fixture, press D [And] between each 
number. For example 1 And 2 And 5 Enter will select 1, 2, 5. 

• To select a range of fixtures, press F [Through]. For example 1 
Through 8 Enter will select 1-8. 

• To miss out fixtures in a range, use E [Not], for example 1 
Through 4 Not 3 Enter will select 1, 2, and 4. 

• The @ softkey sets a dimmer level to the selected fixtures, for 
example 1 Through 8 @ 5 Enter will set 1-8 at 50%. (You can 
choose whether 50% is entered as “5” or “50” in the User Settings 
– see section 11.1.3 on page 91). When you press @ there are 
softkey options for Full, Off and +/- (increase or decrease 
brightness). 

• You can work with Groups using the Group button, for example 
Group 1 And Group 2 Not 5 Enter will select all fixtures in group 1 
and group 2 except for fixture 5. 

• When entering a command, the command line is shown on the 
display. You can go back using the grey ← button and you can 
abandon the line using the grey → button. 

 

3.1.7 Attribute groups - IPCGBES 
To make life a bit simpler, the Pearl groups together attributes which 
have similar effects, using the letters IPCGBES.  

I-Intensity (dimmer, strobe shutter) 

P-Position (pan, tilt) 

C-Colour (colour wheel, CMY mixing) 

G-Gobo (gobo wheels, gobo rotate, gobo position) 

B-Beam (iris, focus, zoom, beam shaper) 

E-Effects (prism) 

S-Special (motor speeds) 

These groups are used to select which attributes you want to work with 
in many of the functions on the console, particularly when you are 
“masking off” certain attributes from being saved. 

3.1.8 Using fixture groups 
You can create groups of fixtures or dimmer channels, which can then 
be quickly selected together by pressing a grey palette button or typing 
the group number. You can, for example, make a group for each type 
of fixture, or group by stage left / stage right, etc. 

1> Select the fixtures/dimmers you want in the group (the order in 
which you select them will also be stored in the group). 

2> Press the grey Group button (top right of the numeric keys). 

3> Press B [Record Group] 

4> Use softkey A to enter a number for the group, or B [Provide a 
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legend] to set a legend. 

5> Press a Palette button (below a preset fader) where you want to 
store the group, or press C [Store] to store as a numbered group. 

6> Press Clear then repeat from 1 to store other groups. 

• To select all the fixtures/dimmers in a group, just press the grey 
palette button for the group. 

• The order in which you originally selected the fixtures when 
creating the group is also stored. This takes effect when you use 
the last fixture – next fixture functions described in the next 
section, and when you use Shapes, Fan mode and Fixture Overlap 
functions. 

• Groups are shown on the heads-up display. 

You can also recall a group by its number: 

1> Press the grey Group button. 
2> Type in the number of the group you want to recall. 

3> Press A [Recall Group]. 

• The Group button also gives you facilities on the softkeys to edit 
and delete groups. 

3.1.9 Stepping through selected fixtures one at a time 
If you have selected a range of fixtures, or a group, the Pearl has 
functions to step through the selected fixtures one at a time. This can 
make it easier to program a range of fixtures because you don’t have to 
select each one manually. 

This mode uses the Prev/Next/All/Hilight buttons to the right of the Go 
button. 

1> Select a range of fixtures or a group. 
2> The Prev and Next buttons will select the fixtures in the range one 

at a time (in the order you selected them).  

3> The ALL button will select all fixtures in the programmer 
(everything which has been selected since Clear was last 
pressed). 

• The Hilight function can be used to highlight the output of the 
selected fixture (make it brighter onstage), see the next section. 

3.1.10 Highlighting the selected fixture 
When stepping through a fixture selection using the Prev/Next/All 
buttons, you can highlight the selected fixture on stage. This makes it 
very easy to see which fixture you are controlling. The other fixtures in 
the selection go to a dimmed level. 

Press the HiLight button to enable highlight mode. Press HiLight again 
to disable hilight mode. When you are in hilight mode, the hilighted 
attribute is overridden and any changes you make to it are not stored in 
the programmer (so if the hilight uses intensity, you cannot change the 
intensity of the fixture). 

3.1.11 Align fixtures 
You can copy attributes from one fixture to another using the Align 
Fixtures function. This is very useful, for example, if you’ve accidentally 
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left a fixture out of a cue you can copy settings from its neighbour. 

1> Select the fixtures you want to Align. 

2> Press ML Menu then D [Align Fixtures]. 

3> Set the mask to include the attribute groups you want to copy 
(using the Attribute Bank buttons on the right of the console,.or 
the softkeys set options for exclude and include all attributes). 

4> Press the handle of the fixture you want to copy the settings from. 

 

3.1.12 Flip 
Moving head fixtures can point at the same stage position from two 
possible yoke positions. Sometimes to get the fixture moving the same 
as other fixtures, you need to swap to the opposite yoke position and 
the Flip function lets you do that.   

1> Select the fixtures you want to Flip. 
2> Press ML Menu then C [Flip Pan and Tilt]. 

 

3.1.13 Fan mode 
Fan mode automatically spreads out the values on a selected range of 
fixtures. If used on pan and tilt, the result is spreading out “rays” of 
light beams. The first and last fixtures of the range are affected most, 
and the central fixtures are affected least. The amount of fan can be set 
using the attribute wheels. 

As with shapes, the order in which you select the fixtures sets how the 
fan effect works. The fixtures you select first and last will be the ones 
which change most. If you use a group to select the fixtures, the order 
you selected the fixtures when you recorded the group is used. 

The fan effect, while normally used on pan or tilt attributes, can be 
applied to any attribute. 

1> Select the fixtures you want to fan. 
2> Press the blue Fan button. 

3> Select the attribute you want to Fan using the attribute bank 
buttons. 

4> Set the amount of fan using the attribute wheels. 

5> Turn off Fan by pressing the Fan button again when you have 
finished. 

 

Fan mode needs to be used on at least 4 fixtures to give good effects. 
If you have an odd number of fixtures, the central fixture will not move 
in fan mode. 

Press the Fan button again to leave Fan mode. Any effects you have set 
will remain in the programmer.  

• It’s fairly easy to accidentally leave Fan mode turned on and be 
very confused about why the wheels aren’t working properly, so 
turn it off as soon as you have completed the effect. 
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3.2 Advanced options 
3.2.1 The ML menu button 

When the Pearl is at the top menu, the ML Menu button opens the 
Moving Light menu which contains options to Locate Fixture (same as 
the Locate button) and to run Macros on fixtures such as Lamp On, 
Lamp Off, Reset etc. The Align Fixtures and Flip functions as described 
above are also in this menu. 

If another menu is loaded, the ML Menu button latches the current 
menu. Press Exit to get back to the top menu so that you can access 
the Moving Light menu. 
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4.  Palettes 
This chapter contains: About palettes; shared and normal palettes; 
recalling a palette; storing a palette; palette masks.  

When programming a show you will find that you frequently use certain 
positions, colours, etc. The Pearl lets you store these settings so you 
can recall them at the touch of a button rather than having to find them 
on the wheels every time. Palettes are stored and selected using the 
grey Palette buttons and you can set legends for the palette values so 
that you know what you’re getting.  

4.1 Create 
4.1.1 Palette values stored as a reference 

The most important thing about palettes is that when you use a palette 
value in a cue, the Pearl stores a reference to the palette, rather than 
the actual value. This means that if you program your cues using 
palettes, you can easily change all the positions in your show just by 
reprogramming a few palette entries rather than having to reprogram 
all the cues. This is handy if you are touring and have to cope with 
different stages or truss heights every show. 

4.1.2 Which attributes are stored in palettes 
A palette entry can store any or all attributes of a fixture, so you could 
store position, colour and gobo in the same palette entry. However, it’s 
easier to operate the Pearl if you have some palettes which only set 
positions, some for colour, some for gobo and so on. It’s also best to 
group similar palettes together on the console buttons to make them 
easier to find, so have an area for Colour palettes, and another area for 
Position palettes, and so on. 

In addition, palettes may be either Shared or Normal. Shared palettes 
are used where the same value is set for all fixtures of the same type – 
for example when setting colours, 
the “Red” palette would set the 
same colour values for “Red” to 
all MAC 2000 fixtures. Normal 
palettes are used when each 
fixture requires its own value - for 
example when programming 
positions, each fixture will have a 
different setting.  

4.1.3 Storing a palette 
This is how you save a palette 
value: 

1> Press Clear to clear the 
programmer.  

2> Select the fixtures for which 
you want to store palette 
values.  

3> Using the attribute buttons 
and wheels, set the 
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attributes you want in the palette entry. You can store any or all 
attributes of a fixture in each palette entry. 

4> Press the blue Store Palette button 

5> Select which attributes are to be recorded in the palette using the 
Attribute Bank buttons – anything lit up will be saved. This is 
called the palette Mask. It’s best to save only one type of attribute 
(e.g. Tilt/Pan). Softkeys D and E also controls the Mask (see 
below). 

6> All unused Palette buttons will flash. Press a grey preset Palette 
button to store the palette. Or enter a palette number and press F 
[Store] 

• The console will automatically set the palette as 
Shared or Normal (by checking if the values to be 
stored are the same across all fixtures of the same 
type). A “magic wand” icon on the softkey 
indicates automatic setting. You can override the 
setting by pressing the softkey C, in which case a 
“user” icon is displayed to indicate a user locked 
state. 

• D [Set Mask] allows you to specify which attribute groups will be 
included in the palette. You can also use the grey Attribute Bank 
buttons on the right hand edge of the console to set the mask. 

• E [Record By…] allows you to control how the mask is used when 
saving the palette. The options are: 
[Channel in programmer] records only channels which are in the 
programmer (which have been changed) 
[Group in programmer] records all channels in any attribute group 
which has one or more channels in the programmer. For example 
if Cyan is in the programmer, all colour channel settings will be 
recorded even if not in the programmer. 
[Group in mask] records everything included by the mask set on 
the attribute buttons 
[Mixed] records by attribute group for Position and Colour but by 
channel for all other controls. 

• You can set a legend for the palette while you are saving it using B 
[Provide a legend]. The legend is shown on the HUD, along with 
the palette number you set, and one or more of the letters 
IPCGBES showing which type of attributes are contained in the 
palette. 

• If you press a Palette button which is already used, the Pearl 
offers you options to A [Cancel], B [Replace], C [Merge] or D 
[Edit] the existing palette. [Replace] will erase the palette and 
save only the latest changes you have made. [Merge] will combine 
your changes with the palette. [Edit] allows you to change the 
legend or user number of the palette. 

4.2 Playback 
4.2.1 Recalling a palette value 

To recall a palette value, this is what you do: 

1> Select the fixtures to be changed. Shared palettes can be set to 
any fixture of the same type. Normal palettes will set individual 
values to each fixture. 
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2> Press the grey preset Palette button you want to recall. The 
palette will be set to the selected fixtures. 

• You can make palettes fade over a time when you recall them, see 
section 4.7.1 below. 

• You can recall a palette by its number by typing 
the number on the numeric keypad and selecting B 
[Apply Palette] from the softkeys. If you enter a 
palette number which does not exist, a warning 
symbol appears on the [Apply Palette] button. 

4.2.2 Palette pages 
You can select different pages of palettes using the Pages of Fixtures 
buttons. 

You can also recall a palette from any page using its number by doing 
the following: 

1> Select some lights 
2> Press the Palette button above the numeric keypad 

3> Type in the number of the palette you want to recall. 

4> Press Enter 

4.2.3 Quick palettes 
You can configure the console for “quick palettes” so that if you press a 
palette button when no fixtures are selected, the palette will be set to 
all the fixtures the palette applies to. For example if you’ve got some 
colour palettes programmed for your MAC 2000’s, pressing one of the 
palettes when no MAC 2000’s are selected will set the colour to all the 
MAC 2000’s. 

This option is set on the VDU menu Tools > User Settings > Panel > 
Enable Global Quick Palette. 

 

4.3 Edit 
4.3.1 Editing palettes 

You can edit a palette entry by recalling it, making the changes you 
want, then saving the new information back on top of the existing 
palette entry. The Pearl will give you options on the softkeys to Replace 
or Merge the palettes. If you select Merge, anything you haven’t 
changed will not be affected, values you have changed or added will be 
amended.  

• You can set the console to “Always Merge” (so it doesn’t ask you) 
using option A of the User Settings (hold down the Avo button to 
set these). You can also press the palette button a second time to 
select the Merge option. 

• You can add additional fixtures to a palette without affecting 
existing ones. For example, if you have colour palettes for Mac 
600s, you can add colours for your Mac 500s without affecting any 
previously recorded values in the palette. 

• You can remove attributes from palettes using the Off function, 
see section Removing attributes from cues using “Off” on page 57. 
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4.3.2 Setting legends for palettes 
You can enter a legend for each palette which is displayed on the HUD. 

1> Press the Palette button above the numeric keypad. 

2> Press the grey preset palette button for the palette you want to 
legend, or enter the palette number. 

3> Press B [Legend=xx] to change the legend. 

4> Type the legend on the keyboard. 

5> Press Enter when you have finished. 

• The IPCGBES attribute 
groups contained in the 
palette are displayed 
below your legend, so for 
example Position palettes 
will show a P, colour 
palettes a C and so on. 
The green N refers to a 
“Normal” palette rather 
than a S for “Shared”.  

4.4 Copy 
4.4.1 Copying palettes 

To copy a palette: 

1> Press the blue PhotoCopy button. 

2> Check softkey A is [Copy] 

3> Press the Palette/Flash button of the palette to be Copied. 

4> Press the Palette/Flash you want to Copy it to. 

5> Press ML Menu to keep the Copy mode active, so you can keep 
copying things without having to reselect the option. Press Exit to 
leave copy mode. 

• You can copy multiple palettes by holding down the first button of 
the range then pressing the last button of the range. 

• Option C [Copy Legends] can be changed to [Don’t copy legends] 
so that the copied palettes are given default legends. 

• Option B [Retain Layout] is used when copying multiple palettes. 
If set to [Bunch up] this option will remove any gaps in the palette 
selection. 

4.5 Delete 
4.5.1 Deleting palettes 

You can delete a palette entry by pressing the blue Delete button, then 
the grey Palette button to be deleted. Press the palette button again to 
confirm the deletion. You can also press the Palette button above the 
numeric keypad and use the softkey options to delete palettes. 
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4.6 Moving 
4.6.1 Moving palettes 

To move a palette: 

1> Press the blue PhotoCopy button. 

2> Press A until the option shows [Move]. You can also press 
PhotoCopy again to toggle this option. 

3> Press the Palette/Flash button of the palette to be Moved. 

4> Press the Palette/Flash you want to Move it to. 

5> Press ML Menu to keep the Move mode active, so you can keep 
Moving things without having to reselect the option. Press Exit to 
leave Move mode. 

• You can move multiple palettes by holding down the first button of 
the range then pressing the last button of the range. 

• Option B [Retain Layout] is used when moving multiple palettes. If 
set to [Bunch up] this option will remove any gaps in the palette 
selection. 

4.7 Timing 
4.7.1 Fading a palette and fixture overlap 

A timed palette is a very useful tool allowing easy "busking" of shows. 
When a palette is recalled in this way, a time is added and the palette 
fades in over that time. 

Additionally you can set Fixture Overlap, which means that if you recall 
the palette to a group of fixtures, the change will be applied in 
sequence to each fixture in the group. This is a very quick way to busk 
some amazing effects. Fixture Overlap=100% means that all fixtures 
will change together. Fixture Overlap=0% means that each fixture must 
complete its fade before the next will start its fade. 

1> Select some fixtures 
2> Type in the fade time for the palette on the numeric keypad 

3> Press C [Fade Time] to set palette fade, or D [Fixture overlap] to 
change the fixture overlap setting 

4> Press a preset palette button to recall the palette 

Palette fading can be very useful when recalling a palette live during a 
show, as you can smoothly move fixtures to a new position or change 
colour slowly (on colour mixing fixtures). 

Palettes applied with a fade time do not get put into the programmer, 
so will not be saved in any cues; don’t use fade times when 
programming. This is to ensure that when used in a live situation, the 
next cue will override the palette and play back as intended. 
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5.  Shapes 
This chapter contains: Selecting a shape; changing the size and speed 
of a shape; spreading a shape across multiple fixtures; editing shapes 
which are running.  

The Pearl, in common with other Avolites consoles, has a shape 
generator (sometimes known as an Effects Generator on other 
consoles). This allows you to quickly create exciting light shows using 
lots of movement and changes, with the minimum of programming. 

A shape is simply a sequence of 
values which can be applied to 
any attribute of a fixture. A 
circle shape, for example, 
applied to the pan and tilt 
attributes, would cause the 
fixture to move its beam around 
in a circular pattern. You can 
set the centre point of the 
circle, the size of the circle and 
the speed of the circle 
movement. 

In addition to position shapes, there are a large number of other 
shapes available in the Pearl. The shapes are defined for a particular 
attribute such as colour, dimmer, focus and so on. Some shapes will 
not work with some fixtures; focus shapes, for example, can produce 
nice “focus pull” effects on fixtures which have DMX focusing, but will 
do nothing on fixtures which don’t have focusing. 

When you use a shape with more than one fixture, you can choose to 
either apply the shape identically to all the fixtures, or offset them so 
that the shape runs along the 
fixtures creating “wave” or 
“ballyhoo” type effects. This is 
called the Phase of the shape. 

 

5.1 Playback 
5.1.1 Creating a shape 

To create a shape you simply pick 
it from a list on the softkeys. 
Shapes are listed using the 
IPCGBES attribute groups, so you 
can pick from a list of Dimmer 
shapes, or a list of Pan/Tilt 
shapes, or Colour shapes, and so 
on. You can also pick from a list of 
All Shapes.  

When you choose a shape, it will 
be applied to all selected fixtures.  

1> Select the fixtures the shape is to be applied to. 
2> At the main menu press C [Shape Generator]. 
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3> Press A [Create] to start a new shape. 

4> Press a softkey to select the attribute type to use in the shape or 
press H [All shapes] for a full list. 

5> Press a softkey to select a shape. You can type a search word on 
the Qwerty keyboard to search for a particular shape. 

6> The shape will be applied to all selected fixtures. 

• Shapes are based on the current settings of the fixture, so a circle 
would move around the current pan-tilt position of the fixture. 

• You can change the base value of a shape (e.g. the centre of a 
circle) by changing the attributes using the wheels in the usual 
way. You can reduce the Size to zero (see next section) to help 
you see what the base value actually is. 

• You can run more than one shape at a time by repeating the 
above procedure. You can run several shapes on one fixture. 

• Press C [Shape Generator] then B [Edit] to show what shapes are 
running. 

• If you apply the same shape to two different groups of fixtures, 
the shape will appear twice on the shape list. You can edit the two 
shapes separately to give different directions, speeds etc (see 
later) 

• Each shape is designed to work on a particular attribute. Obviously 
if the fixtures don’t have the attribute, you will not see any effect 
if you use the shape. 

• Each shape has a default size and speed setting (defined in the 
shape file). 

5.1.2 Changing size and speed of a shape 
It is easy to change the size and speed of a 
shape after it has first been created. If the 
display above the wheels is showing Phase 
rather than Size/Speed, press softkey C to 
select [Adjust Speed and Size]. 

1> Control the speed of the shape using the 
left hand wheel. 

2> Control the size of the shape using the 
right hand wheel. 

3> The size and speed is shown above the wheels on the display. 

Other things to know about size and speed of shapes: 

• If you have more than one shape running, the controls operate on 
the most recent one. You can edit the parameters of any shape 
that’s running using the Edit Shape function, see section 5.2.1. 

• The minimum size is zero. This will “hide” the shape, and the 
fixture will resume its previous settings. The shape is, however, 
still active. 

• You can edit the shape 
individually on each 
fixture by selecting the 
fixtures you want to 
change. The HUD shows 
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the individual shape parameters for each fixture. 

5.1.3 Changing the phase of a shape across multiple fixtures 
Shapes get more interesting (and look more impressive) when you 
apply them to multiple fixtures. The Pearl lets you control how a shape 
is phased across several fixtures.  

The sequence of the shape across the fixtures is controlled by the order 
in which you selected the fixtures when you created the shape.. 

1> Press softkey C to select [Adjust Phase]  
2> Control the phase of the shape using the left hand wheel. 

 

 

The display above the left hand wheel shows the phase in degrees. For 
example, 180 degrees repeats every 2 fixtures, 90 degrees repeats 
every 4 fixtures, 60 degrees repeats every 6 fixtures, and so on.  

5.2 Edit 
5.2.1 Editing shapes which are running 

If more than one shape is running, you can select which one is 
connected to the control wheels using Shape option B [Edit].  

1> If you are not in the Shape menu, press the C [Shape Generator] 
at the top menu. 

2> Press B [Edit]. 

3> By the softkeys is a list of the currently running shapes. 

Phase=180 deg (2 fixture repeat) Phase=60 deg (6 fixture repeat) 

Phase=22.5 deg (16 fixture repeat) Phase=0 deg 
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4> Press a softkey to make the shape active. The active shape is 
highlighted. 

5> Press Enter to get back to the Shape Generator menu. 

• If you applied the same shape several times to different fixtures, 
you can change each copy of the shape independently. 

5.2.2 Reversing a shape 
You can reverse the direction of a shape by pressing D [Reverse 
Shapes] from the shape menu, then pressing the softkey for the shape 
you want to reverse. 

5.3 Delete 
5.3.1 Deleting shapes 

You can delete a running shape by pressing C [Delete] from the shape 
menu, then pressing the softkey for the shape you want to delete. 

5.4 Advanced options 
5.4.1 Shape fade mode 

When a shape is stored in a cue, you can set how the shape fades in 
using the cue’s Mode setting (use A [Edit Times] from the main menu 
then E [Fade Mode]). 

Modes 0,1 and 3: The shape size will grow from zero to the 
programmed size using the time/delay settings of the cue.  
Mode 2: The shape size will be set by the fader position. It will start at 
zero and grow to its programmed size when the fader reaches 100%. 
 

If a new cue is fired which controls the same attributes (for example, a 
second shape controlling the same fixtures as a currently running 
shape), the new shape will crossfade from the running shape. 
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6.  Cues 
This chapter contains: HTP and LTP channels; how the Pearl works 
when programming; recording a cue; playing back a cue; changing 
playback pages; setting fade times for a cue; copying and deleting 
cues; the include function; editing cues; the “off” button; blind mode;  
using shapes in cues.  

The Pearl has many functions for producing a complex light show, and 
the most fundamental part is a Cue, in which you can store a “look” you 
have created using your lights.  

The Pearl has 600 playbacks, in 60 pages of 
10, which can be used to store cues or 
chases (sequences of “looks”). Chases are 
covered in the next chapter. The playbacks 
are controlled using the sliders and flash 
buttons across the near edge of the console. 
The split roller is used to select the page of 
cues or chases – each group of 10 playback 
faders can be set to its own page. 

The Pearl Expert also allows you to store 
cues on the preset faders. 

The cue functions on the Pearl are very powerful; the first part of this 
section explains the basics of how the Pearl uses cues. 

6.1 Create 
6.1.1 How the Pearl works when programming 

When you select one or more dimmers or fixtures for control, they are 
loaded into the Editor. You can then use the wheels and palettes to 
change the settings on the fixture. You can also apply shapes to it. 

If a fixture is selected after you have changed some attributes then the 
current list of fixtures is emptied and a new list is started. 

All fixtures and attributes that have been edited since the last Clear are 
stored in the Programmer. The order in which you selected the fixtures 
is also stored, and is used with the Fixture Overlap function. When you 
record a cue, the contents of the Programmer are saved into the cue.  

When you press Clear (by the numeric keypad), the programmer and 
editor are emptied. This makes sure you don’t record fixtures you don’t 
want. You also need to press Clear when you finish programming, 
because any attributes in the programmer will override playbacks.  

Fixtures which are in the programmer are shown in light blue on the 
VDU Stage View. Attributes in the programmer (the things you have 
changed) are shown in cyan on the VDU Stage View screen. 

Firing a cue does not place the values from the cue in the programmer 
(although the Include function lets you do this, see section 6.3.2 on 
page 56). 

Playback faders & split roller 
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6.1.2 Creating a cue 

1> Press Clear to clear the programmer. This ensures that you are 
starting with a clean slate. 

2> Set up the look using the fixtures. You can save shapes in a cue. 
Remember that only the fixtures you have selected will be saved 
in the cue. 

3> Press the blue Memory/Cue button. 

4> Press the Swop button of an empty Playback to record the cue. 
(Select a new roller page first if you want to use a different page). 
You can also record a cue onto a Preset fader by pressing its 
Swop/Select button. 

5> Press Clear to clear the programmer. Repeat from 2 to program 
more cues. 

Other useful things to know about recording cues: 

• A [Record Mode] lets you select Record By Fixture (all attributes of 
any modified fixture are saved), Record By Channel (only modified 
attributes are saved) or Record Stage (all fixtures with a non-zero 
dimmer channel are saved). Record By Channel is useful if you 
want to layer multiple cues to create an effect. 

• If you are recording a lot of cues, you can press the ML Menu 
button to keep the Record Cue menu active. Press Exit to leave 
Record Cue mode. 

• The roller has a segment above each playback fader to allow you 
to write on the name of the cue using the low-tech but reliable 
method of marker pen (use a strip of tape on the roller surface). 
You can then see at a glance what’s in each cue. 

• The Heads Up 
Display shows a 
legend for each 
playback fader. 
You can change 
this to help you 
remember what’s 
in it. Press  B [Set 
Legend], then the playback Swop button (or the preset Select 
button), then enter a legend on the keyboard. Press Enter to store 
it.  

6.1.3 Using shapes in cues 
As you would expect, any shapes you have set up will be saved as part 
of the cue.  

You can create a cue which contains a shape with no base reference 
values; a shape cue like this can then be fired with other cues to 
overlay the shape on the cue and give you instant effects based around 
the settings in that cue. When recording the cue, use the “Off” function 
to remove the other attributes from the programmer as described in 
section 6.3.3 on page 57. 

 

6.2 Playback 
Because it’s possible to play back a large number of cues at the same 
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time, the Pearl has to have rules on how it combines the output from 
different cues. These are called HTP and LTP rules. 

6.2.1 HTP and LTP 
The Pearl treats control channels in two ways: 

• Dimmer or intensity channels work on the principle of “Highest 
Takes Precedence” (HTP). If an HTP channel is active at different 
levels in several cues, the highest level will be output. When you 
fade out a cue, the HTP channels fade out with it. 

• All other channels work on the principle of “Latest Takes 
Precedence” (LTP). The latest change takes over from any other 
values, so the most recent cue to be turned on is the one which is 
output. When you fade out a cue, LTP channels retain their values 
until changed by another cue. 

6.2.2 Playing back a cue 
To fire (play back) a cue, raise the fader. (Make sure there are no 
values in the programmer by pressing the Clear button, because 
anything in the programmer will override the playback). 

• You can fire several cues at once. 

• The HTP levels in the cue will be mastered by the fader level; for 
example if you set the fader at 50% then all HTP levels will be 
50% of their programmed values. 

• LTP channels are triggered as soon as the fader goes above 0%. If 
a fade time is programmed the LTP channels will start to fade; if 
there is no fade time they will snap to position (unless the cue is 
set to Mode 2; see the timings section 6.7 on page 58 for details 
of modes). 

• You can Flash the cue by pressing the grey flash button. You can 
Swop (solo) the cue by pressing the blue Swop button (all other 
active cues will turn off while the button is pressed). Flash and 
Solo only work when the key is set to Run mode. 

6.2.3 Changing playback pages 
You change playback pages using the Roller.. Each roller has 3 pages 
set using the Roller Page buttons just above the left hand roller. 

If you have stored cues on the preset faders, you select different pages 
of preset faders using the Pages of Fixtures buttons above the numeric 
keypad. 

• Playbacks which are fired when you change page remain active. If 
you want to fire a cue on a fader which is already on from a 
previous page, lower the fader to zero then raise it again. The cue 
from the previous page will stop and the cue from the new page 
will fire.  

• If you return to a page with an active playback, the fader will not 
resume control of the playback until it matches the current level of 
the playback. This prevents the playback level “jumping” when the 
fader is first moved.  
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6.3 Edit 
6.3.1 Editing a cue 

You can edit any part of a cue you have already saved simply by 
making the changes and saving the new information on top of the cue. 

1> Press Clear to empty the programmer. 
2> Fire the cue you want to edit, so you can see what you are doing. 

Kill all other cues to avoid confusion. 

3> Select the fixtures you want to change, and make the changes. 

4> Press Memory/Cue. 

5> Press the Swop button for the cue you are editing. 

6> Press C [Merge] (the cue being edited is highlighted on the HUD) 

7> The Pearl will merge the existing cue with your changes. 
Unchanged information is not affected. 

• If you want to overwrite the cue entirely, use the option B 
[Replace] at step 6. 

• To speed up editing, you can set the console to “Always Merge” 
the cue. This is option A in the User Settings (press Avo and select 
User Settings). 

• You can also press the Swop button for the cue a second time to 
select the “Merge” option (quicker than selecting the softkey 
Merge option). 

6.3.2 The Include function 
The Include function lets you load selected parts of a cue back into the 
programmer. (Normally, only manual changes to fixtures are put in the 
programmer). You can then use this to make a new cue. This is useful 
if you want to make a cue which is similar to one you already have, or 
to build a new cue from various parts of other cues.  

There are two modes, Quick Include and Advanced mode. Quick Include 
simply reloads the whole cue. Advanced mode allows you to specify 
which attributes of which fixtures you want to load into the 
programmer. So, for example, if you have a cue which contains 
position, colour and gobo information for 8 fixtures, you can use the 
include function to load only the colour information for 4 of the fixtures 
into the programmer. You could then “Include” position information 
from another cue into the programmer, and build up a new cue using 
information from several existing cues. 

1> Press Include (above numeric keypad). 
2> Softkey A selects [Quick Include] or [Advanced mode] 

3> Press the Swop button of the cue you want to include. 

4> All fixtures in the cue will be selected. If you don’t want them all, 
deselect the fixtures you don’t want. The fixtures in the cue are 
highlighted on the HUD and on the fixture buttons. 

5> Use B [Set Mask] or the Attribute Bank buttons to select which 
Attributes you want to include (All are included by default – 
Softkey C turns them all off and D turns them all on). Softkey E 
lets you include or exclude Shapes from the cue. 

6> Press Enter. The selected attributes of the selected fixtures will be 
loaded into the programmer. 
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7> Repeat from 2 to include other attributes from the same fixtures, 
or repeat from 1 to include other fixtures. 

6.3.3 Removing attributes from cues using “Off” 
The “Off” button allows you to remove an attribute which has been 
stored in a cue, as if you’d never recorded it.  

For example, suppose you recorded a cue which had scans at a certain 
position, with the colour set to green. If you later decide that you don’t 
want a colour recorded at all in the cue, so that the colour set by 
previous playbacks will remain, you set the colour values to Off in the 
programmer, which will remove those values from the cue. You can 
also use the Off function to remove complete fixtures from a cue by 
selecting all the attributes. 

 

Setting an attribute to Off is not the same as recording an attribute at 
zero, since this would change the attribute when the cue was fired. It is 
the same as excluding that attribute using the mask when recording, 
and the attribute will remain unchanged when the cue is fired. 

1> Use the Quick Include function (described in previous section) to 
load the cue you want to change into the programmer. 

2> Press the blue OFF button to display the Off menu. 

3> All fixtures in the cue will be selected. If you don’t want to change 
them all, deselect the fixtures you don’t want. 

4> Use the softkeys to select which Attributes you want to remove. 

5> Press Memory/Cue, then set the record mode to [Replace], and 
press the Swop button of the cue to update it. 

• You can also remove attributes from palettes using the Off 
function. 

6.4 Copy 
6.4.1 Copying a cue 

Copying a cue is very simple on the Pearl. 

1> Press the blue PhotoCopy button. 

2> Press the playback Swop button (or the preset fader) of the cue 
you want to copy. 

3> Press the playback Swop button (or the preset fader) where you 
want to store the copy. 

• To create a linked copy, after pressing Photocopy press A to select 
the option [Link] - or press PhotoCopy twice. The linked cue will 
have the same cue information in it, but can have different timings 
and playback options. 

• The ML Menu button keeps the Copy mode active, so you can keep 
copying things without having to keep selecting the option. Press 
Exit to leave Copy mode. 

• You can copy multiple cues by holding down the first button of the 
range then pressing the last button of the range. 

• Option C [Copy Legends] can be changed to [Don’t copy legends] 
so that the copied cues are given default legends. 
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